Getting Started with VMware Fusion

VMware Fusion for Mac OS X
You can find the most up-to-date technical documentation on the VMware Web site at:
http://www.vmware.com/products/fusion/support.html
The VMware Web site also provides the latest product updates.
If you have comments about this documentation, submit your feedback to:
docfeedback@vmware.com

© 2007–2008 VMware, Inc. All rights reserved. Protected by one or more U.S. Patent Nos. 6,397,242, 6,496,847, 6,704,925, 6,711,672, 6,725,289, 6,735,601, 6,785,886, 6,789,156, 6,795,966, 6,880,022, 6,944,699, 6,961,806, 6,961,941, 7,069,413, 7,082,598, 7,089,377, 7,111,086, 7,111,145, 7,117,481, 7,149,843, 7,155,558, 7,222,221, 7,260,815, 7,260,820, 7,269,683, 7,275,136, 7,277,998, 7,277,999, 7,278,030, 7,281,102, 7,290,253, 7,356,679, 7,409,487, 7,412,492, and 7,412,702; patents pending.
VMware, VMware Fusion, the VMware “boxes” logo and design, Virtual SMP, and VMotion are registered trademarks or trademarks of VMware, Inc. in the United States and/or other jurisdictions. All other marks and names mentioned herein may be trademarks of their respective companies.
Contents

Getting Started with VMware Fusion  5
Introduction  5
    What Is a Virtual Machine?  5
What You Can Do with VMware Fusion  6
System Requirements for VMware Fusion  7
Install or Upgrade VMware Fusion  8
Start VMware Fusion  9
Getting Up and Running  10
Create a Windows Virtual Machine with Windows Easy Install  10
Create a Virtual Machine from the Boot Camp Partition  12
Import an Existing PC to a Virtual Machine  13
Import an Existing Parallels Desktop or Microsoft Virtual PC 7.0 Virtual Machine  13
Download a Virtual Appliance from the VMware Virtual Appliance Marketplace  14
Using Mac Keyboards in a Virtual Machine  15
Correct Sound Problems in Virtual Machines Running Vista 32-Bit Edition  16
Quit Your Virtual Machine  17
VMware Fusion Resources  17
Supported Guest Operating Systems  18
    Supported 32-Bit Guest Operating Systems  18
    Supported 64-Bit Guest Operating Systems  20
Getting Started with VMware Fusion

Introduction
VMware Fusion™ allows you to run your favorite PC applications on your Intel-based Mac. Designed from the ground up for the Mac user, VMware Fusion makes it easy to take advantage of the security, flexibility, and portability of virtual machines to run Windows and other x86 operating systems side by side with Mac OS X.

What Is a Virtual Machine?
A virtual machine is a software file that behaves just as a physical computer does. A virtual machine contains a display, a hard disk, one or more processors, memory, and all the other hardware that goes into a typical physical machine—but all components are virtualized. That is, these elements of a virtual machine are all created by software and stored in files on your Mac.

The virtual machine runs in a window on your Intel-based Mac. You install an operating system and applications in the virtual machine and operate it as you would a physical computer.

The Mac that you run a virtual machine on is typically referred to as the host. In this context, the virtual machine is referred to as a guest.
What You Can Do with VMware Fusion

With VMware Fusion, Intel-based Mac users can:

- **Run your favorite Windows and Linux applications on an Intel-based Mac** – With VMware Fusion, you can run your favorite applications side by side with Mac applications using virtual machines running a wide range of Windows and Linux operating systems, without rebooting.

- **Create virtual machines** – VMware Fusion provides a New Virtual Machine Assistant to guide you through the process of creating a virtual machine, including Windows Easy Install and Linux Easy Install—making installing your favorite operating system easier than ever.

- **Import virtual machines** – Import virtual machines created with Parallels Desktop or Microsoft Virtual PC for Mac directly from VMware Fusion.

- **Graduate from Boot Camp** – VMware Fusion can make use of your existing Boot Camp partition, or, when you’re ready, can import your Boot Camp partition into a virtual disk, letting you reclaim your Boot Camp space.

- **Keep your Windows safe** – VMware Fusion lets you take multiple snapshots—pictures in time—of your virtual machines, keeping them safe in case of any issue. And VMware Fusion AutoProtect takes automatic, periodic snapshots to keep your virtual machines safe from unexpected harm.

- **Get the most out of your Mac** – Run powerful 64-bit virtual machines, including server operating systems like Windows Server, Linux Server, and Mac OS X Server Leopard in virtual machines. Attach up to 8GB of RAM and four virtual processors to a virtual machine, for server-grade performance.
Run multiple operating systems while protecting the integrity of your Mac – VMware Fusion lets you safely run virtual machines isolated from the Mac by making use of the hardware-level security and fault isolation of virtualization solutions.

Evaluate and use prebuilt applications easily – With VMware Fusion, you can download and safely run prebuilt applications designed to solve specific problems in virtual machines that are available from the growing library of virtual appliances. See the Virtual Appliance Marketplace at http://vam.vmware.com/.

The Virtual Appliance Marketplace includes virtual machines from various software vendors, as well as virtual machines that are preconfigured with popular open source software. With VMware Fusion you can download and try a completely configured Linux virtual machine without having to be a Linux expert or you can try preconfigured business appliances with applications from leading software vendors, including Oracle, Red Hat, Novell, BEA, SpikeSource, IBM, and MySQL.

System Requirements for VMware Fusion

The minimum system requirements for installing and using VMware Fusion are:

- Any Mac with an Intel 1.5GHz or faster processor
- 1GB of RAM, 2GB recommended
- 500MB of free disk space for VMware Fusion, and at least 5GB of free disk space for each virtual machine
Getting Started with VMware Fusion

- Mac OS X version 10.4.11 or higher
- Operating system installation media (disk or disk image) for virtual machines. Windows operating systems available separately from Microsoft and your favorite retailers

**NOTE** You must have enough memory to run Mac OS X, plus the memory required for each guest operating system and for applications on the Mac and in the virtual machine. See your guest operating system and application documentation for their memory requirements.

### Install or Upgrade VMware Fusion

If you are upgrading VMware Fusion, you do not need to uninstall the version installed on your computer. VMware Fusion upgrades the existing version automatically. Installation and upgrade does not modify existing virtual machines.

**To install or upgrade VMware Fusion**

1. If you are upgrading an existing VMware Fusion installation, make sure that no virtual machines are open and that VMware Fusion is not running.

2. If you are installing from a CD, insert it into the drive, and skip to Step 5.

   The contents of the CD appear in a VMware Fusion Finder window.

3. If you are installing from a download, first download VMware Fusion from the VMware Web site at [http://www.vmware.com/mac/](http://www.vmware.com/mac/).

   Click the **Download** link and follow the subsequent links for an Electronic Download Distribution. Click the download link and save the application to your Mac. The VMware Fusion disk image is saved to your default download directory: `VMware-Fusion-<2.xx>-<xxxxx>.dmg`, where `<2.xx>` is the application version and `<xxxxx>` is the build number for the download release.
Getting Started with VMware Fusion

4 Double-click **VMware-Fusion-<2.x.x>-<xxxxx>.dmg** to mount it.
   The contents of the disk image appear in a VMware Fusion Finder window.

5 Double-click the **VMware Fusion** icon to launch the Installation Assistant.

6 Follow the instructions in the Assistant to install VMware Fusion.
   At the end of the installation, the Assistant prompts for your serial number.

7 Enter your serial number.
   If you do not have a serial number, click **Get Serial Number** to go to the VMware Web site, where you can license VMware Fusion and get a serial number.
   You can continue without entering a serial number, but you cannot power on a virtual machine until you have entered a valid serial number.
   You can enter your serial number by choosing **VMware Fusion > Buy Now or Enter License**.

Start VMware Fusion

To start VMware Fusion

In the Applications folder, double-click **VMware Fusion**.

The Virtual Machine Library window appears. From this window, you can create a virtual machine, browse for an existing virtual machine to open, open a virtual machine you have used recently, import a virtual machine created in another virtualization product, or go to the VMware Virtual Appliance Marketplace.

Save VMware Fusion in your Dock by clicking and holding the icon, and selecting **Keep in Dock**.

For instructions on configuring, running, and closing VMware Fusion, see the VMware Fusion Help.
Getting Up and Running

There are five ways to get up and running quickly with VMware Fusion:

- Create a new Windows virtual machine.
- Use an existing Boot Camp installation.
- Import your existing Windows PC.
- Import a Parallels Desktop or Microsoft Virtual PC virtual machine.
- Download a preconfigured virtual appliance.

Create a Windows Virtual Machine with Windows Easy Install

When you create a Windows virtual machine, you can use the VMware Fusion Windows Easy Install feature to automatically install Windows and VMware Tools in your virtual machine. VMware Fusion will create your virtual machine, automatically select the default Windows installation options, and install VMware Tools, which loads the drivers required to optimize your virtual machine’s performance. You can also choose to have Windows Easy Install automatically make your home folder available to Windows as a shared folder, so you can share files between the virtual machine and your Mac.

Windows Easy Install is available for the following Windows operating systems:

- Windows Vista, Windows XP, Windows 2000

If you are not using one of these Windows operating systems in your virtual machine, or you want to install the operating system manually, see the VMware Fusion Help for details on creating virtual machines.
To create a Windows virtual machine using Windows Easy Install

1. Insert your Windows CD-ROM into your optical drive.
   You will need a valid Windows product key. Windows CDs that came shipped with a previous physical computer are likely locked to that machine and might not work.

2. From the Virtual Machine Library window, click the **New** button or choose **File > New**.
   The New Virtual Machine Assistant launches.

3. In the Introduction panel, ensure that **Install this operating system** is selected, and click **Continue**.

4. In the Windows Easy Install panel, enter your **Display Name/Account Name**, **Password** (optional), and **Windows Product Key**.
   The entry in the **Display Name/Account Name** field appears in information boxes as the name your Windows software is registered to. It is not the Windows user name. The entry in the **Password** field is the password for the Windows administrator account only. The Product key is not provided by VMware. It is on the sticker attached to the packaging for the Windows operating system CD-ROM.

5. In the Sharing panel, indicate how you want the new virtual machine to handle basic file sharing.

6. In the Finish panel, click **Finish**.
   VMware Fusion installs Windows. This can take up to 45 minutes. After installing Windows, VMware Fusion installs VMware Tools, and powers on the virtual machine.
Create a Virtual Machine from the Boot Camp Partition

Boot Camp is Apple software that enables an Intel-based Mac to run Windows XP (32-bit only) and 32- and 64-bit Windows Vista. But Boot Camp requires you to choose between Mac or Windows at boot time. Boot Camp creates separate Mac and Windows partitions on your hard disk to create a dual-boot environment. You can use your Windows XP or Windows Vista Boot Camp partition as a VMware Fusion virtual machine. This enables you to

- Use your Boot Camp virtual machine and your Mac without rebooting to switch between them.
- Share files easily between your Boot Camp virtual machine and your Mac, through shared folders, and by dragging and dropping files or cutting and pasting text.

**NOTE** If VMware Tools is not installed, and you reactivate Windows in your Boot Camp virtual machine, and subsequently boot your Boot Camp partition natively, you will be prompted to reactivate Windows. Reactivating Windows in your native Boot Camp partition will result in your Boot Camp virtual machine requiring reactivation the next time you power it on, and so forth. Installing VMware Tools solves this problem. If you have VMware Tools installed, you will need to reactivate Windows only when you first power on your Boot Camp virtual machine.

**To create a virtual machine from the Boot Camp partition**

1. From the Virtual Machine Library window, select **Boot Camp partition**, which is automatically detected, and click the run arrow.
2. Enter your Mac password to access the Boot Camp partition.

You must have administrator privileges to use the Boot Camp as a virtual machine. VMware Fusion creates a virtual machine from your Boot Camp partition and starts Windows.
3. After Windows boots from your Boot Camp virtual machine, VMware Fusion starts the installation of VMware Tools to enable full virtual machine functionality and optimize performance for your Boot Camp partition when used as a virtual machine. Follow the onscreen instructions and restart your virtual machine when prompted.

4. When the VMware Tools installation is complete, reboot your computer.

The first time you power on your Boot Camp virtual machine after installing VMware Tools, you will need to reactivate Windows.

Import an Existing PC to a Virtual Machine

VMware Fusion makes it easy for Windows users to make the switch to a Mac. To move from a physical PC to VMware Fusion, download our free VMware Converter Starter Edition to migrate your existing Windows PC in a VMware Fusion-compatible virtual machine, then copy the virtual machine from your PC to your Mac.

For details on downloading VMware Converter Starter Edition and a document walking you through the process, go to www.vmware.com/info?id=700.

Import an Existing Parallels Desktop or Microsoft Virtual PC 7.0 Virtual Machine

VMware Fusion makes it easy to import your existing virtual machine to VMware Fusion. Launch VMware Fusion and select Import from the File menu. Select your virtual machine and click Import.

For more details, refer to the VMware Fusion online help.
Download a Virtual Appliance from the VMware Virtual Appliance Marketplace

You can download a wide range of preconfigured virtual machines from the VMware Virtual Appliance Marketplace. Preconfigured virtual machines are also referred to as virtual appliances. Available virtual appliances include operating systems such as Linux, FreeBSD, and Solaris, and include preconfigured collaboration and security appliances.

To download a virtual appliance from the VMware Web site

1. From the Virtual Machine Library window choose VMware Fusion > Download Virtual Appliances.

   VMware Fusion opens the VMware Virtual Appliance Marketplace Web site in your default browser.

2. Search the virtual appliance directory to find the virtual machine you want.

   Follow the instructions to download it to your local computer.
Using Mac Keyboards in a Virtual Machine

PC and Mac keyboards differ, so you must press certain key combinations to enable certain PC commands on a Mac keyboard. See Table 1. To learn more about keyboard and mouse options in VMware Fusion, refer to the VMware Fusion Help available in the Help menu.

Table 1. PC and Mac Keyboards

<table>
<thead>
<tr>
<th>PC Keyboard</th>
<th>Apple External Keyboard</th>
<th>MacBook and MacBook Pro Built-In Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Screen</td>
<td>F14</td>
<td></td>
</tr>
<tr>
<td>Scroll Lock</td>
<td>F15</td>
<td></td>
</tr>
<tr>
<td>Pause/Break</td>
<td>F16</td>
<td></td>
</tr>
<tr>
<td>Backspace</td>
<td>delete</td>
<td>delete</td>
</tr>
<tr>
<td>delete (Forward Delete)</td>
<td>delete</td>
<td>fn+delete</td>
</tr>
<tr>
<td>Insert</td>
<td>help</td>
<td></td>
</tr>
<tr>
<td>Num Lock</td>
<td>clear</td>
<td>fn+num lock F6</td>
</tr>
<tr>
<td>Command (Windows logo key—between Ctrl and Alt keys)</td>
<td>⌘</td>
<td>⌘</td>
</tr>
<tr>
<td>Alt</td>
<td>alt option</td>
<td>alt option</td>
</tr>
</tbody>
</table>

**NOTE** On the MacBook and MacBook Pro built-in keyboards, the function keys are not accessible unless you press Fn plus the desired Function key.
Correct Sound Problems in Virtual Machines Running Vista 32-Bit Edition

When you install Microsoft Vista 32-bit edition in a VMware Fusion virtual machine, there is no sound output. To correct this problem, run Windows Update to update the sound driver from within Vista.

To update the sound driver in a VMware Fusion virtual machine running Windows Vista 32-bit edition

1. In the virtual machine, from the Windows start menu, Control-click or right-click Computer and select Properties.

2. In the left pane, under Tasks, select Device Manager.

3. When prompted for your permission to continue, click Continue. Windows displays the Device Manager.

4. Control-click or right-click the Multimedia Audio Controller with a warning symbol (indicating that there is no driver) and select Update Driver Software.

5. At the prompt How do you want to search for driver software?, select Search automatically for updated driver software. Windows finds and installs the appropriate driver for your virtual sound card.

6. When you are prompted to restart, click Restart Now. Sound should now work in your Microsoft Vista 32-bit virtual machine.
Quit Your Virtual Machine

The VMware Fusion suspend feature lets you quickly save the entire current state of your virtual machine, including all running applications, so you can return to this state without restarting your virtual machine. Using the Suspend command instead of Shut Down lets you get back up and running quickly.

To completely shut down the virtual machine instead, use the Shut Down command.

**NOTE** Boot Camp virtual machines do not support the suspend and snapshot features because you can reboot into Windows using Boot Camp, which would invalidate suspend and snapshots.

VMware Fusion Resources

In addition to this document, you can find information about using VMware Fusion at the following sources:

- VMware Fusion has a rich, searchable help system available from the Help menu.
- For self-help resources, including self-paced video tutorials on how to get the most out of VMware Fusion, see the VMware support portal at http://www.vmware.com/products/fusion/support.html.
- For answers to frequently asked questions, check the VMware Fusion FAQ on the VMware Fusion product Web site at http://www.vmware.com/products/fusion/faqs.html.
- We also recommend joining the VMware Fusion Community at http://www.vmware.com/community/forum.jspa?forumID=371. The VMware Fusion Community Forum is a site where VMware Fusion users can exchange information, questions, and comments with each other to get the most out of VMware Fusion.
Supported Guest Operating Systems
VMware Fusion supports over 60 guest operating systems, including Windows 3.1 through Windows 2008, Linux, Solaris, and FreeBSD. The operating systems listed here have been tested in VMware Fusion virtual machines and are officially supported. For the most recent list of guest operating systems supported by VMware products, with notes on installing the most common guest operating systems, see the VMware Guest Operating System Installation Guide: http://pubs.vmware.com/guestnotes/.

Supported 32-Bit Guest Operating Systems
VMware Fusion supports the following 32-bit guest operating systems:

- Mac OS X Server v10.5 Leopard (experimental)
- Windows Vista Business, Enterprise, Ultimate, Home Basic, and Home Premium Editions
- Windows Vista Business, Enterprise, Ultimate, Home Basic, and Home Premium SP1 Editions
- Windows XP Professional SP2, Home Edition SP2
- Windows XP Professional SP3, Home Edition SP3
- Windows 98 SE
- Windows Server 2003 Enterprise Edition SP2
- Windows 2000 Server SP4, Advanced Server SP4, Windows 2000 Professional SP4
- Windows NT 4.0 Server SP6a, Workstation SP6a
- Windows Me, Windows 3.1, Windows 95 SP1, MS-DOS 6.x
- SUSE Linux Enterprise Server 10, 9 SP3
- SUSE Linux Enterprise Server and Desktop 10 SP2
- SUSE Linux 10.1, 9.3
- Novell Netware 6.5 SP7
- Novell Linux Desktop 9 SP2
- Novell Open Enterprise Server SP2
- Red Hat Enterprise Linux 5.0 Update 2 (Advanced Server, Enterprise Server, Workstation)
- Red Hat Enterprise Linux 4.0 Update 6, 3.0 Update 9
- Red Hat Enterprise Linux 2.1—stock 2.4.9-e3 (Advanced Server, Enterprise Server, Workstation)
- Red Hat Linux 9.0—stock 2.4.20-8, upgrade 2.4.20-20.9
- Red Hat Linux 7.0—stock 2.2.16-22, upgrade 2.2.17-14
- Solaris x86 10 (Update 5)
- Ubuntu Linux 8.04, 7.10, 6.10, 5.10
- FreeBSD 7.0, 6.1, 5.5
- Turbolinux Enterprise Server 8
- Turbolinux Desktop 10
Supported 64-Bit Guest Operating Systems

VMware Fusion supports the following 64-bit guest operating systems:

- Mac OS X Server v10.5 Leopard (experimental)
- Windows Vista Business, Enterprise, Ultimate, Home Basic, and Home Premium Editions
- Windows Vista Business, Enterprise, Ultimate, Home Basic, and Home Premium SP1 Editions
- Microsoft Windows XP Professional SP2
- Windows Server 2003 Enterprise Edition SP2
- SUSE Linux Enterprise Server 10 SP2
- SUSE Linux Enterprise Desktop 10 SP2
- SUSE Linux 10.1, 9.3
- Red Hat Enterprise Linux 5.0 Update 2, 4.0 Update 6, 3.0 Update 9
- Solaris x86 10 (Update 5)
- Ubuntu Linux 8.04, 7.10, 6.10, 5.10
- Mandriva Linux 2008
- FreeBSD 7.0, 6.1, 5.5
- Turbolinux Server 10